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Legal Notices

COPYRIGHT NOTICE 
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This document is protected by copyright and distributed under licenses restricting its use, copying and 
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TRADEMARKS
Quest, Quest Diagnostics, the associated logo and all associated Quest Diagnostics marks are the registered 
trademarks of Quest Diagnostics.
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DISCLAIMER OF WARRANTIES
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CONSEQUENTIAL DAMAGES, INCLUDING WITHOUT LIMITATION, LOSS OF USE, DATA OR 
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PRODUCT(S) AND/OR THE SOFTWARE DESCRIBED IN THIS DOCUMENT AT ANY TIME.

RESTRICTED RIGHTS LEGEND 
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Introduction 
This AutoReceive User Manual provides information on installing, configuring, and using 
Care360 AutoReceive. It also describes how to add, modify, and remove subscriptions that 
deliver results to your printer or computer from your service provider.

Intended Audience 
This user manual is intended for personnel who configure and maintain subscriptions 
enabling automatic transmittal of lab results from laboratory service providers to their care 
sites. The manual assumes your computer, printer, and network (if applicable) are set up and 
ready to use and that you are familiar with the basic skills needed to use them.

Note: To better understand what a subscription is, see “Configuring Subscriptions” on 
page 14.
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What’s New in This Release 
AutoReceive 7.0 provides the following updates and enhancements:

● Radiology Result Print Ordering. AutoReceive now prints radiology results according to 
the same configuration setting as lab results. All print results are ordered by file name or 
file date based on your settings.

For more information, see“Configure Printable Test Results” on page 21.

● Simplified Advisory Report. AutoReceive’s advisory report no longer displays empty 
headings; headings are now only displayed in the advisory report if the report contains 
corresponding advisory messages.

For more information, see“Configure Printable Test Results” on page 21.

● Expanded Operating System Compatibility. AutoReceive now supports the following 
operating systems:

❍ Microsoft Windows®' 7

❍ Microsoft Windows Server®' 2008

● Expanded Service Mode Support. AutoReceive can now be used in service mode under 
all operating systems. 
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Documentation Conventions 
This manual uses the following conventions:

● Manual titles, special terms, Web page and dialog box titles, menu items, toolbar button 
names, labels that appear on Web pages and dialog boxes, and keyboard key names 
appear in italic.

Italic is also used to indicate variables. For example, an e-mail address might be presented 
as name@company.com. When typing the address, you would use the actual user name and 
company name rather than name and company.

● Words that are being emphasized appear in bold.

● Text that you type as well as messages and prompts that appear on the screen appear in 
this type style.

● The greater than symbol (>) indicates a series of menu items to click. For example, the 
instructions to click the File menu item and then click Open might be presented in the 
following way: “Click File > Open.” 

● This manual calls your attention to important information in several ways:  

Note: A note indicates exceptions to the stated rule, or information that emphasizes or 
supplements important points in the main text. A note can supply information that might apply 
only in a special case. 

CAUTION! A caution indicates that failure to take or avoid a specified action could result in 
losing data. When you see a caution, follow the instructions carefully.
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Abbreviations and Acronyms 
The following is a list of abbreviations and acronyms that are used in this manual. 

Abbreviation/Acronym Description

CD-ROM Compact Disc Read-Only Memory

DPI Dots Per Inch

EMR Electronic Medical Record

HL7 Health Level 7 Standard Interface

GB Gigabyte

HTTP Hypertext Transfer Protocol

HTTPS Hypertext Transfer Protocol, Secure

ISP Internet Service Provider

JRE Java™' Runtime Environment

KB Kilobyte

LAN Local Area Network

MB Megabyte

MHz Megahertz

PDF Portable Document Format

POCT Point-of-Care Testing

RAM Random Access Memory

SOAP Simple Object Access Protocol

TIQ Test In Question

TNP Test Not Performed
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Chapter 1: Getting Started 

About AutoReceive
AutoReceive, part of the Care360 suite of products, provides a secure method for receiving, 
routing, and storing lab result reports from service providers. Once AutoReceive is installed, 
you can create subscriptions to receive results in one or more of the available formats, such 
as HL7 or Printable (PDF) test results.

The following graphic illustrates the process of receiving documents from a service provider 
using AutoReceive. 

About Subscriptions 
A subscription is a defined delivery method that identifies the document types (HL7 and 
PDF) that you want to receive, how and when results are delivered to you, and how you prefer 
the results be stored, saved or printed for clinical use. You can create any number of HL7 
and PDF subscriptions, each with differing delivery options, if you choose.

A subscription includes several parameters that you must configure: 

● Document type (for example, HL7 or PDF).

● Subscription name.

● Save or print location (defined at your discretion).

● Type of result (final results only or partial and final results).

● Frequency of transmission (for example, every 60 minutes).

● Disabled days of the week (for days your office is closed).

● Print order (for example, by file date or file name).

● HL7 filename extension (for HL7 subscriptions only).

● Provider Account (a combination of information identifying your care site and your 
Quest Diagnostics Account Number).
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A provider account can be associated with only one HL7 subscription and one PDF 
subscription type. If you want reports from all your provider accounts to be delivered 
according to the same set of parameters, that is, at the same time(s) each day, to the same 
printer/folder, etc., you might choose to configure only two subscriptions—one for HL7 and 
one for PDF— and associate all your provider accounts with these two subscription types.

If, however, you want to specify variations to your subscriptions to accommodate differing 
delivery requirements among your clinicians, you can create and name additional HL7 and 
PDF subscriptions and associate them with accounts that are not already associated with 
another subscription of the same document type.

Following is an example of a subscription: if you want to receive HL7 final results (document 
and result type) from Quest Diagnostics for the Northern Medical Group (provider 
account), you can configure an HL7 subscription to retrieve results every 60 minutes 
(frequency of transmission) to a folder on your network (save location). You might have 
already configured other HL7 subscriptions with differing parameters for other provider 
accounts, but AutoReceive offers the flexibility to configure additional subscriptions to suit 
your clinical requirements. See “Configuring Subscriptions” on page 14 for more 
information on creating subscriptions.

The following image shows two configured subscriptions and the specified delivery 
parameters for the selected account. For more information, see “Accessing Subscription 
Summary Information” on page 41. 
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About Running AutoReceive as a Windows Service 
AutoReceive will run as a Windows service by default, unless a previous install of AutoReceive 
on the same machine ran as a standard application, in which case this setting will be retained. 
A Windows service is an application that runs when Windows is started, and continues to run 
in the background as long as Windows is running. Running as a Windows service enables 
AutoReceive to continue downloading or printing results even when no user is currently 
logged into Windows.

From the user perspective, there are no visible changes to the AutoReceive user interface 
when AutoReceive is running as a Windows service, except for some minor modifications to 
the status messages that appear in the status window (for more information on setting 
notification options, see “Changing Notification Options” on page 49). The service-related 
status messages that may appear include the following: 

You can still access the AutoReceive menu options from the notification area (at the far right 
of the Windows taskbar), and you can open the AutoReceive application from the Start 
menu. The primary difference is that exiting AutoReceive (by right-clicking the AutoReceive 
icon and selecting Exit) closes the user interface, but does not stop the Windows service from 
running. 

For This Status This Status Window Appears

AutoReceive is loading

AutoReceive is in Service Mode, and the service is 
connected

AutoReceive is in Service Mode, and the service is 
stopped

AutoReceive is in Service Mode, but the service 
mode is unavailable (this can be the result of 
various technical and security issues)

Note: AutoReceive will only operate properly as a Windows Vista, Windows 7, or Windows Server 
2008 service if you run it as an administrator.
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Installing AutoReceive 
AutoReceive installation is a two-part process. After installing AutoReceive, you must log in 
and configure your subscription(s) in order for AutoReceive to open upon restart and 
receive results. You will also be prompted to configure AutoReceive for your network 
immediately following installation. See “Logging In to AutoReceive” on page 11 for more 
information. 

System Requirements 
Review the hardware and software requirements outlined below before you install 
AutoReceive. For optimal performance, maintain the preferred hardware requirements.

Microsoft ®' Windows Vista, Windows 7, and Windows Server 2008

Notes:
● In order to install AutoReceive for Windows Vista, Windows 7, or Windows Server 2008, you must 

run the installer as an administrator on your computer. On any platform, you must have 
permission to install applications, and you must have sufficient permissions to run the AutoReceive 
executable file and the Java Runtime Environment (JRE) that is installed with AutoReceive. You 
must have permissions for the following directories:
❍ If you are installing AutoReceive for a 32-bit version of Windows, AutoReceive installs to 
C:\Program Files\AutoReceive.

❍ If you are installing AutoReceive for a 64-bit version of Windows, AutoReceive installs to 
C:\Program Files(x86)\AutoReceive.

● If you are installing AutoReceive on a computer running Windows Vista, AutoReceive will update
twice unless you uninstall the previous version prior to upgrading. (For more information, see 
“Uninstalling AutoReceive” on page 34.) This repeated update is not dangerous to your data.

Item Requirement

Processor Preferred: 1 GHz or higher

Minimum: 800 MHz or higher 

Memory Preferred: 1 GB RAM

Minimum: 512 MB RAM

Hard Disk Preferred: 2 GB with 400 MB of free space

Minimum: 2 GB with 100 MB of free space

Monitor 800 x 600 through 1400 x 1050 resolution 

Disk Drive DVD-ROM or CD-ROM drive

Printer Laser printer connected to a workstation or office network 

Internet Connection 56 KB minimum modem speed for ISP connection 
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Microsoft Windows XP (All Service Packs) 

Microsoft Windows 2000 

Microsoft Windows Server 2003 

Item Requirement

Processor Preferred: 300 MHz or higher Pentium®'-compatible

Minimum: 233 MHz or higher Pentium-compatible

Memory Preferred: 256 MB RAM

Minimum: 128 MB RAM

Hard Disk Preferred: 2 GB with 400 MB of free space

Minimum: 2 GB with 100 MB of free space

Monitor 800 x 600 through 1400 x 1050 resolution 

Disk Drive DVD-ROM or CD-ROM drive

Printer Laser printer connected to a workstation or office network 

Internet Connection 56 KB minimum modem speed for ISP connection 

Item Requirement

Processor Preferred: 300 MHz or higher Pentium-compatible

Minimum: 133 MHz or higher Pentium-compatible

Memory Preferred: 256 MB RAM

Minimum: 128 MB RAM

Hard Disk Preferred: 2 GB with 400 MB of free space

Minimum: 2 GB with 100 MB of free space

Monitor 800 x 600 through 1400 x 1050 resolution 

Disk Drive CD-ROM drive

Printer Laser printer connected to a workstation or office network 

Internet Connection 56 KB minimum modem speed for ISP connection 

Item Requirement

Processor Preferred: 550 MHz or higher Pentium-compatible

Minimum: 133 MHz or higher Pentium-compatible

Memory Preferred: 256 MB RAM

Minimum: 128 MB RAM
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Hard Disk Preferred: 2 GB with 400 MB of free space

Minimum: 2 GB with 100 MB of free space

Monitor 800 x 600 through 1400 x 1050 resolution 

Disk Drive CD-ROM drive

Printer Laser printer connected to a workstation or office network 

Internet Connection 56 KB minimum modem speed for ISP connection 

Notes:
● MedPlus will support the Windows XP (all service packs), Windows 2000, and Windows 

Server 2003 operating systems as long as they are supported by Microsoft Corporation.
● Use Adobe Reader version 5.0 or newer for viewing documentation PDF files, and files that you 

download using AutoReceive.
● The following requirements apply to the printer that you are using to receive and print documents:

❍ Microsoft Windows-supported printer.
❍ Network, serial, parallel, or USB connection.
❍ Print drivers appropriate to your computer’s operating system. PostScript®' printer drivers are 

not supported.
❍ Support for landscape and portrait orientation.
❍ 200 dpi print resolution or higher.

For a list of compatible printers, see the Readme file that is available on the product CD and in the 
AutoReceive install directory. 

Item Requirement
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Install AutoReceive

1. If you are updating an existing version, exit AutoReceive before you continue. (If 
you are installing AutoReceive for the first time, begin with step 2.)

To exit, do the following:

a. Right-click the AutoReceive icon ( ) in the notification area, and then click 
Exit.

b. When prompted, click Yes to confirm that you want to exit.

2. Insert the AutoReceive product installation medium (for example, flash drive or 
CD) into the appropriate drive, and then double-click AutoReceive-7.0.

If you are using Windows Vista, Windows Server 2008, or Windows 7, proceed to 
step 3. Otherwise, proceed to step 4.

3. If you are using Windows Vista, Windows Server 2008, or Windows 7, a User Account 
Control window appears, prompting you as to whether or not the installation should 
continue. Confirm that you want the installation to continue. 

The installer Introduction screen appears.

4. At the Introduction screen, click Next.  

The Please Wait screen appears while the installer prepares to install AutoReceive. 

Tip: If the Please Wait screen appears for an extended amount of time (without finding a 
previous AutoReceive installation), click Previous and then click Next to continue the 
installation (bypassing the Please Wait screen).
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5. If a previous version is detected on your computer, do the following:

a. Exit AutoReceive (as described in step 1), and when the Uninstall Previous Version 
screen appears, click Next. 

b. After the previous version has been uninstalled, click Next to continue the 
installation.

6. Review the Pre-Installation Summary screen for accuracy. 

7. If the Pre-Installation Summary screen information is correct, click Install.

AutoReceive is installed on your computer. Installation may take a few moments. 
When AutoReceive is installed on your computer, the Install Complete screen 
appears. 
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8. Click Done.

The AutoReceive Splash Screen appears. 

The Splash Screen provides a visual indicator notifying you of AutoReceive activity 
(for example, loading and caching document types and provider information from 
the Hub).

AutoReceive starts automatically, and the Network Configuration dialog box appears.

9. If you are installing AutoReceive for Windows Vista, Windows 7, or Windows Server 
2008, and the user who will access AutoReceive does not conform to a built-in user 
role, you must perform the following additional steps:

a. Navigate to C:\Program Files\AutoReceive.

b. Right click the config folder and select Properties > Security.

c. At Group or User Names, select the user or user group who will use AutoReceive.

d. In the Permissions for... area, at Modify, select the Allow check box.

e. Click OK.

f. Repeat steps b through e for the following folders:

a. logs 

b. print_q 

c. staging 

d. status 

e. temp

10. Continue with “Logging In to AutoReceive” on page 11. 

CAUTION! Failure to complete this step will prevent AutoReceive from properly 
assigning and saving some settings.
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Logging In to AutoReceive 
The first time AutoReceive starts, you need to identify your computer’s Internet 
connection—modem or local area network (LAN)—and enter a valid Username and Password 
to initiate the service. After you log in and configure your subscription(s), AutoReceive 
remains active as long as your computer is on. While active, an AutoReceive icon ( ) appears 
in the notification area, which you can use to access a number of menu options. 

You will remain logged into AutoReceive until you manually stop the AutoReceive service (if 
running in Service Mode), exit AutoReceive (if running in Classic Mode), or shut down the 
computer. For information about exiting, see “Starting and Exiting AutoReceive” on 
page 61.

Log In to AutoReceive 

1. At Network Configuration, which displays immediately after installation, identify your 
computer’s Internet connection by selecting one of the following: 

● Select LAN if your computer accesses the Internet using a local area network 
(LAN).

Some LAN connections use a proxy server for HTTP and HTTPS connectivity. 
If your computer uses a proxy server, select the Use proxy server check box, and 
then type the Proxy host and Port information. If your proxy server requires you 
to log in, also type your Username and Password (provided by your System 
Administrator; this is not your AutoReceive Username and Password).

Notes:
● You must run AutoReceive as an administrator under Windows Vista, Windows 7, or Windows 

Server 2008. Failure to do so may cause AutoReceive to run incorrectly.
● If you need to change your Username and/or Password, see “Changing Configuration Settings” on 

page 47.
● If you need to manually start or exit AutoReceive, see “Starting and Exiting AutoReceive” on 

page 61. 
● You can change your connection type later, if necessary, using the Network Configuration option on 

the right-click menu available from the AutoReceive icon in the notification area. See “Changing 
Connection Settings” on page 48 for more information.

● You are allowed three attempts to successfully log in. After three failed login attempts, AutoReceive 
automatically exits. The next time AutoReceive opens, the last known successful login information 
is used. To clarify your login information, contact your System Administrator.
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To determine if your LAN connection uses a proxy server, check your Internet 
browser’s settings by selecting Tools > Internet Options on the browser menu bar. 
Click the Connections tab. Click LAN Settings. See if the Use a proxy server for your 
LAN check box is selected.

● Select Modem if your computer accesses the Internet using a modem. To 
automatically disconnect your modem after each transmission of results, select 
Disconnect after finished download.

2. Click OK.

3. At AutoReceive Setup, type your AutoReceive username and password, and then 
click OK.

4. Begin configuring your first subscription.

For information about configuring HL7 or Printable subscriptions, see 
“Configuring HL7 Test Results” on page 16, “Configuring Printable Test Results” 
on page 21, or “Configuring Clinical Document Uploading” on page 27 
respectively. 
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5. After you have configured one or more subscriptions, click Close.

6. When prompted, click Activate to activate your AutoReceive account. 

Activating your account indicates that you have configured at least one 
AutoReceive subscription, and you are ready to begin receiving results.
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Configuring Subscriptions 
Configuring a new subscription is a three-step process. All three steps must be completed for 
the subscription to be considered active so that you can begin receiving results. An overview 
of the three steps follows:

❑ Choose Subscription. Select the subscription type (HL7, Printable, or Clinical 
Document Upload).

❑ Configure Subscription. Specify the subscription’s parameters, including the retrieval 
schedule and the location to save or print the results.

❑ Associate Account(s). Associate the subscription with one or more provider account(s).

At any time during the configuration process, you can monitor your progress by reviewing 
the top of the configuration window to see the Three Steps to Configure AutoReceive. A check 
mark displays next to each completed step. 

Step 1: Choose Subscription

The first step in creating a new subscription is to select the subscription type, either HL7, 
Printable (PDF) test results, or Clinical Document Upload. Based upon this selection, the 
appropriate parameters display for the second step of the configuration process.

Step 2: Configure Subscription

You can uniquely configure each subscription to meet the needs of your office. You need to 
consider and make selections for the following parameters for each subscription you 
configure:

● Subscription name. The default name is HL7 Test Results for an HL7 subscription, Printable 
Test Results for a PDF subscription, or Clinical Document Upload for a Clinical Document 
Upload subscription. You can change the name to something more meaningful to you if 
you want. For example, if you have multiple service providers from whom you are 
receiving results, you may want to identify the subscription by the service provider’s name. 
An example might be Quest Diagnostics HL7 Test Results.

● File Naming Mode. There are two naming modes that you can select from, to indicate 
how HL7 and PDF files are named: Standard and Enhanced. The Standard naming mode 
uses a timestamp only to name the file, while the Enhanced mode adds a Provider ID, 
Message Control ID (MCID), and Document ID (PDF files only) to the file name to aid 
in matching an HL7 file to any corresponding PDF file(s). 

Examples of the Enhanced file formats are shown below:

❍ HL7: Provider ID-MCID-timestamp.hl7

CAUTION! If you close the Subscription Configuration dialog box prior to completing the 
configuration, your configuration changes are not saved. The three configuration steps listed above 
have associated parameters from which you must make selections. See the descriptions below for the 
selections available for each of the three configuration steps.

Note: The File Naming Mode you select applies to all subscriptions you configure; that is, you only 
need to set it once. You do not need to select it separately for each subscription.
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❍ PDF: Provider ID-MCID-Document ID-timestamp.pdf

Enhanced file naming examples:

❍ HL7: 10088-10200001-1179842547381.hl7

❍ PDF: 10088-10200001-87235-1179842547782.pdf

● Print Order. If you selected Enhanced file naming mode, you can choose the print order 
in which your results will be sorted. You can choose to sort results by File Date, or File Name. 

● Retrieval schedule. The retrieval schedule is defined by your selections for both a retrieval 
time and a result type. Choose a retrieval time by selecting either a specific time or an interval. 
Examples include:

❍ Specific time. You may want to receive results first thing in the morning and at the end 
of the day. To do this, you can select 8:00 A.M. and 6:00 P.M. as the specific times for 
receiving your results. 

❍ Interval. You may want to receive results every four hours. To do this, you can set an 
interval by selecting a duration, for example, every four hours, and a starting time, for 
example 8:00 A.M. The starting time is used to calculate each interval in a 24-hour 
period. For this example, results will save at 8:00 a.m, 12:00 P.M., 4:00 P.M., 8:00 P.M., 
12:00 A.M., and 4:00 A.M.

Additionally, you can determine the result type by selecting either Final Results Only or 
Partial and Final Results for the specified retrieval time.

❍ Final results only. If you make this selection, you will receive results only when all the 
results are complete for a specific requisition. If you choose this option, you may want 
to place orders that require more than one day to complete on a separate requisition. 
This way, you do not delay the receipt of the patient’s labs that have quicker 
turnaround time.

❍ Partial and final results. If you make this selection, you will receive the latest result at 
the time of retrieval, whether it is a partial or final result.

● Disabled day(s) of the week. You may want to disable result retrieval on days that your 
office is closed. To do this, select the day, or days of the week to disable the results 
retrieval. You cannot disable results retrieval for all the days of the week. To disable 
retrieval for more than 6 days, for example, if your office will be closed for a week, exit 
AutoReceive until you want to resume results retrieval again. See “Starting and Exiting 
AutoReceive” on page 61.

● Save location. Determine where you want to save and/or print your HL7 and PDF results. 
Due to the format of HL7 files, they cannot be printed; they can only be saved to a folder 
on your computer or network.

HL7 subscriptions have additional configuration options available such as filename 
extensions and sorting of saved results. For more information on the HL7 configuration 
options, see “Configuring HL7 Test Results” on page 16.

Note: When you select a specific time or interval, AutoReceive retrieves results within a range 
of nine minutes prior to nine minutes after the selected time.

Notes:
● The starting time (for intervals) does not designate the first time the results will be saved. You 

will receive results at the next scheduled interval after you complete the configuration. For 
example, if the intervals are 8:00 A.M., 12:00 P.M., 4:00 P.M., 8:00 P.M., 12:00 A.M., and 
4:00 A.M. (every four hours) and you are setting the configuration at 9:00 A.M., you will receive 
results for the first time at 12:00 P.M.

● If you shut your computer down (without exiting AutoReceive) in the evening and then restart 
it in the morning, new results will save at the next scheduled interval.
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Step 3: Associate Account(s)

The final step of the configuration process is to associate a provider account, or accounts, to 
the new subscription. You can choose from the list of available accounts that displays on the 
Associate Accounts dialog box. If you want, you can select multiple accounts for an individual 
subscription, but each account can be associated with only one HL7 subscription and one 
PDF subscription.

Once a subscription is saved, you can access it later to make any necessary modifications. See 
“Managing Subscriptions” on page 41 for more information on modifying existing 
subscriptions. To create a new HL7 subscription, see Configuring HL7 Test Results below. To 
create a new Printable subscription, see “Configuring Printable Test Results” on page 21.

Configuring HL7 Test Results 
HL7 test result files are saved to a specified location on your computer or network where they 
can then be retrieved by your Electronic Medical Record (EMR) system or any other system 
that reads HL7 test results. Due to their format, HL7 files cannot be printed.

To review the detailed descriptions of subscription parameters, see “Configuring 
Subscriptions” on page 14. Two parameters that are specific to HL7 subscriptions are:

● HL7 file extensions. The default value for the HL7 file name extension is hl7. If your EMR 
system does not recognize files with an .hl7 extension, type the HL7 filename extension 
that is appropriate for your receiving system (for example, .res or .hll).

● Result sorting. HL7 results can be sorted into sub-folders for each account that is 
associated to the subscription. If you want to sort your HL7 results in this manner, select 
the Automatically create file sub-folders using Account IDs option available in the Distribution 
area of the AutoReceive Configuration dialog box. See “Configuring HL7 Test Results,” step 
8 for more information. 

Note: This step is not required for a Clinical Document Upload subscription.
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Configure HL7 Test Results 

1. After a successful login, the AutoReceive Configuration dialog box automatically 
appears, allowing you to create a new subscription.

At Subscription type, click and select HL7 Test Results. 

2. At File Naming Mode, select either Standard or Enhanced to indicate how result files 
are named. (For more information on the naming modes, see “File Naming Mode” 
under “Step 2: Configure Subscription” on page 14.) 

If you change the File Naming Mode, the setting takes effect immediately (that is, the 
next time results are downloaded).

3. At Print Order, select either File Date or File Name to indicate how results are sorted 
or printed.  

4. Click Continue.

5. At Subscription Name, type a subscription name for the HL7 results, if you do not 
want to use the default name HL7 Test Results.

Note: If you would rather configure the Printable subscription first, see “Configuring 
Printable Test Results” on page 21. 

Note: The File Naming Mode you select applies to all subscriptions you configure (including 
HL7 and Printable). If you have selected the mode previously, you do not need to select it 
again. 

Note: In order to use this feature you must first select Enhanced as your File Naming Mode. 
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6. Set the retrieval schedule by selecting one of the following:

● To receive results at specific times, click At specific times, and then click Choose.

At Select Time(s), select the check box next to each desired retrieval time. For 
each selected time, specify whether you want to receive Final Results only or 
Partial and Final Results. 

❍ To receive only final result reports, select Final Results only. All tests on the 
requisition must be complete to receive results.

❍ To receive the latest result, whether it is partial or final, select Partial and Final 
Results.

❍ When you are finished selecting the results type for each specific time, 
click OK.

● To receive results at regular intervals, click Every, and then click and select the 
interval duration and starting time. 

❍ To receive only final result reports, select Final results. All tests on the 
requisition must be complete to receive results.

❍ To receive the latest result, whether it is partial or final, select Partials and 
finals.

7. To disable retrieval for specific days of the week, click the appropriate day(s). 
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8. At Save results in, do one of the following to specify the location to save the HL7 
results: 

● Type the directory or network path in the space provided. For example, type 
C:\AutoReceive HL7 Results.

● To locate the directory or network path where you want to save the HL7 results, 
click Browse.

To sort the HL7 results into sub-folders by the account associated with this 
subscription, select the Automatically create file sub-folders using Account IDs check 
box.

9. At HL7 File Name Extension, type the appropriate file name extension used by your 
EMR system (if it is different from hl7). 

10. To test the configuration settings that you have made, click Test. A sample 
document (test.hl7) is downloaded and stored in the specified directory. 

11. When you have finished configuring the HL7 subscription and have successfully 
tested it, click Continue.

12. At Associate Accounts, do one of the following to select the provider account(s) with 
which the subscription will be associated:

● Individually click the checkbox(es) to select the service provider(s).

● Click Select All to select all service providers.

If you want to clear the service providers, click Clear All, and then make your 
selections again. 

Note: If AutoReceive is running as a Windows service and you specified a network drive in 
step 8, the Test button may not accurately confirm the ability to save a results file; the 
account under which the service runs may not have the same access permissions as the 
current user. If you encounter problems saving files to a network drive, try saving to a local 
drive, or switch AutoReceive to Classic Mode instead of Service Mode. (For more 
information, see “Switching Between Service Mode and Classic Mode” on page 64.)
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13. Do one of the following: 

● To return to the previous configuration screen to make changes prior to saving, 
click Back.

● To save your selections and return to the first configuration screen, click Save.

If you are prompted to create a directory in which to save the results, click 
Yes to all. When you are finished configuring subscriptions, click Close from the 
configuration screen.

● To exit the subscription configuration (without saving your changes) and return 
to the first configuration screen, click Cancel.

14. If you specified a directory (in step 8) that does not yet exist on your computer, you 
are prompted to create the new directory. To create the new directory, click 
Yes to All. 

When you have completed the subscription, the Manage Subscriptions dialog box 
appears, displaying a summary of the subscription you created. 

Tips:
● Accounts that appear shaded and display the status of Pre-Assigned are not available 

for selection; they are already associated with another subscription.
● If your accounts do not appear for selection on the Associate Accounts dialog box, 

contact Customer Support.
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Configuring Printable Test Results 
Printable (PDF) results can be saved to your computer or network drive, and can be printed 
automatically on a local or network printer. To review the detailed descriptions of 
subscription parameters, see “Configuring Subscriptions” on page 14.

Configure Printable Test Results 

1. After your first successful login, the AutoReceive Configuration dialog box 
automatically appears, allowing you to create a new subscription. 

At Subscription type, click and select Printable Test Results. 

2. At File Naming Mode, select either Standard or Enhanced to indicate how result files 
are named. (For more information on the naming modes, see “File Naming Mode” 
under “Step 2: Configure Subscription” on page 14.) 

If you change the File Naming Mode, the setting takes effect immediately (that is, the 
next time results are downloaded).

3. At Print Order, select either File Date or File Name to indicate how results are sorted.  

Note: The File Naming Mode you select applies to all subscriptions you configure (including 
HL7 and Printable). If you have selected the mode previously, you do not need to select it 
again. 

Note: In order to use this feature you must first select Enhanced as your File Naming Mode. 
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4. Click Continue. 

5. At Subscription Name, type a subscription name for the PDF results, if you do not 
want to use the default name Printable Test Results.

6. Set the retrieval schedule by selecting one of the following:

● To receive results at specific times, click At specific times, and then click Choose. 

At Select Time(s), select the check box next to each desired retrieval time. For 
each selected time, specify whether you want to receive Final Results only or 
Partial and Final Results. 

❍ To receive only final result reports, select Final Results only. All tests on the 
requisition must be complete to receive results.

❍ To receive the latest result, whether it is partial or final, select Partial and Final 
Results.

❍ When you are finished selecting the results type for each specific time, 
click OK.

● To receive results at regular intervals, click Every, and then click and select the 
interval duration and starting time. 

❍ To receive only final result reports, select Final results. All tests on the 
requisition must be complete to receive results.

❍ To receive the latest result, whether it is partial or final, select Partials and 
finals.

7. To disable retrieval for specific days of the week, select the appropriate day(s). 



23 Configuring Subscriptions
• 
• 
• 
•
•
•

8. To configure one or more subscriptions to print and/or save the downloaded 
result documents, do one or more of the following:

● If applicable, specify the Number of copies you want to print for each test result 
(maximum of 10 copies). 

● If you selected two or more copies for each test result, you can have your results 
collated by selecting the Collate Multiple Reports check box. If you are printing 
more than one test result, selecting Collate Multiple Reports will collate those 
results.

9. To automatically print test results, select the Print checkbox, and then click and 
select a local or network printer. To select more than one printer, hold down the 
Ctrl key while you select the printers.

● To generate a summary of your printed test results, select the Enable Print 
Summary Page checkbox.

● An example of the Result Summary Report is shown below.

❍ The Result Summary Report displays a summary of printed Lab results 
contained within a batch including Test in Question (TIQ), Test Not 
Performed (TNP), and Abnormal results. The Result Summary Report also 
displays a summary of Radiology results contained within a batch listed 
separately from the Lab results.
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❍ In the event there are no results for a result type (lab, radiology), only the 
section heading will display.

● To generate an advisory message report alerting you that your batch contains 
Abnormal, Test in Question (TIQ), or Test Not Performed (TNP) results, select 
the Enable Advisory Message Page checkbox.

● An example of the Advisory Message Report is shown below.
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❍ The Advisory Message Report highlights patient orders being requested in a 
batch that contain Test in Question (TIQ) and Test Not Performed (TNP) 
results.

● To save test results, select the Save files to disk checkbox, and then type the 
directory or network path where you want to save the files. For example, type 
C:\AutoReceive Printable Results.

To locate the directory or network path where you want to save the printable 
results, click Browse. To test your configuration settings, click Test. A sample 
document (test.pdf) is downloaded and printed and/or stored in the specified 
directory. 

10. When you have finished configuring the Printable subscription and have 
successfully tested it, click Continue.

11. At Associate Accounts, do one of the following to select the provider account(s) with 
which the subscription will be associated:

● Individually select the service provider(s).

● Click Select All to select all service providers.

Notes:
● The Enable Print Summary Page and Enable Advisory Message Page checkboxes are 

selected by default for new subscriptions.
● When the Print checkbox is selected, the Enable Print Summary Page and Enable 

Advisory Message Page checkboxes will be enabled. When the Print checkbox is 
cleared, these checkboxes will be disabled.

● If there are reports with an advisory message (TIQ, TNP), these will print before the 
rest of the results within the batch.

● If you have requested advisory messages for a result category, and there are no 
messages for that category when the report is run, no corresponding heading for 
that category will appear in the Advisory Message Report.

CAUTION! If AutoReceive is running as a Windows service and you specified a 
network drive in step 8, the Test button may not accurately confirm the ability to save a 
results file; the account under which the service runs may not have the same access 
permissions as the current user. If you encounter problems saving files to a network 
drive, try saving to a local drive, or switch AutoReceive to Classic Mode instead of 
Service Mode. (For more information, see “Switching Between Service Mode and 
Classic Mode” on page 64.)



26
• 
• 
• 
•
•
•

Chapter 1: Getting Started 

If you want to clear the service providers, click Clear All, and then make your 
selections again. 

12. Do one of the following: 

● To return to the previous configuration screen to make changes prior to saving, 
click Back.

● To save your selections and return to the first configuration screen, click Save. 

If you are prompted to create a directory in which to save the results, click Yes to 
all. When you are finished configuring subscriptions, click Close from the 
configuration screen.

● To exit the subscription configuration (without saving your changes) and return 
to the first configuration screen, click Cancel.

13. If you specified a directory (in step 8) that does not yet exist on your computer, you 
are prompted to create the new directory. To create the new directory, click Yes to 
All. 

When you have completed the subscription, the Manage Subscriptions dialog box 
appears, displaying a summary of the subscription you created.

Tips:
● If you want to clear the service providers, click Clear All and make your selections 

again.
● Accounts that appear shaded and display the status of Pre-Assigned are not available 

for selection; they are already associated with another subscription.
● If your accounts do not appear for selection on the Associate Accounts dialog box, 

contact Customer Support.
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Configuring Clinical Document Uploading
Non-electronic, clinically-relevant documents (scanned documents) can be uploaded to 
your computer or network drive, and transferred electronically into the Care360 EHR via the 
Hub. To review detailed descriptions of subscription parameters, see “Configuring 
Subscriptions” on page 14.

Configure Clinical Document Uploading

1. After your first successful login, the AutoReceive Configuration dialog box 
automatically appears, allowing you to create a new subscription. 

At Subscription type, click and select Clinical Document Upload. 

2. Click Continue. 

3. At Subscription Name, type a subscription name for the Clinical Document Upload 
if you do not want to use the default name Clinical Document Upload.

Note: This option will only be available if the Hub Account for this client has Document 
Upload service activated. 



28
• 
• 
• 
•
•
•

Chapter 1: Getting Started 

4. At Parent Path, click Choose to select the directory where AutoReceive will look for 
documents to be uploaded to the Hub.

You can only have one Parent Path per subscription.

5. A folder named Document Upload is created within the selected parent path.

Files copied to this directory will be sent to the Hub.

To upload a file, AutoReceive must have the ability to gain exclusive access to the 
file. The Windows user that AutoReceive is running under must have write 
permissions to the directory involved. Also, the file cannot be marked as Read Only. 
The file must be copied completely to the directory before it can be uploaded to 
the Hub.

6. A sub-folder named Errors is created inside the Document Upload folder. Files that 
cannot be processed because they are too large (larger than 5MB) are placed in 
this folder. 

● Files that can’t be processed because of communication failures or the inability 
to establish an exclusive lock will remain in the Document Upload folder and 
the system will try to re-send them.

● Any folder within the Document Upload folder will not be processed.

7. At Provider Account, select a Provider Account from the drop-down menu. This 
identifies the Org in Care360 where the documents are to be sent. 

When you have completed the subscription, the Manage Subscriptions dialog box 
appears, displaying a summary of the subscription you created. 

Configuring Point-of-Care Testing (POCT) Results
Point-of-Care Testing (POCT) results can be uploaded to AutoReceive using an external 
POCT device, for delivery through the Hub to Lab Orders and Results. 

Note: AutoReceive must be able to have an exclusive lock on a document before it can be 
uploaded. The folder selected as the Parent Path needs to have proper permissions set so 
AutoReceive can establish an exclusive lock on the documents.

Note: The client will be responsible for ensuring documents are placed correctly in this 
directory.

Note: You can only have one Provider Account defined for a subscription. 

Note: For information on configuring and installing the software for a specific POCT device, refer 
to the device’s User Manual.
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Configure POCT Results

1. Start the POCT device software (refer to the device’s User Manual for specific 
instructions).

2. Connect power to the POCT device’s docking station.

3. Insert the USB cable from the external POCT device’s docking station into a USB 
port on the computer that is running the device software (refer to the device’s User 
Manual for specific instructions).

4. From the toolbar, select Tools > Primary Docking Stations.

The Primary Docking Station dialog box appears.

5. Double-click the Serial Number of the docking station, or select the Serial Number and 
then click Edit. (The Serial Number is a 10-digit numeric number that can be found 
on the bottom of the docking station.)
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The Primary Docking Station Settings dialog box appears.

6. If Not Used is selected at DHCP, type the Address, Subnet mask, Default Gateway, and 
DNS, provided by the customer site in their respective fields. 

The information in these fields is specified for the docking station, not the 
computer that is running AutoReceive. For example, if DHCP is not used, you will 
need an IP address assigned for the docking station. This IP address will go in the 
Address field.

7. At O.R. Address:, type the IP Address of the computer that is running AutoReceive.

8. At O.R. Port: type 12500.

9. Click Send.

10. After clicking Send, perform the following steps:

a. Disconnect the USB cable from the computer.

b. Disconnect the power cable from the docking station.

c. Connect the Network cable to the docking station.

d. Re-connect the power cable to the docking station.

11. Use a POCT device to obtain a measurement so that the device has data to send. 
Then, insert the POCT device into the docking station. The results are uploaded 
to AutoReceive, and then automatically routed through the Hub, where they are 
queued for delivery.

12. Right-click on the AutoReceive Icon, and then click View Status Log. 
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The Status Log appears. If the results were delivered successfully, a status message 
will so state. If the delivery was unsuccessful, an error message will appear. 
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Configuring AutoReceive to Write to a Network Drive
By default, the AutoReceive service runs as the Local System account and does not have 
privileges to write to a network drive. In order to allow the AutoReceive Service to write to a 
network drive, the service must be re-configured to run using an account with the correct 
privileges.

To re-configure the service, log into Windows as an Administrator and stop AutoReceive 
(both the UI and service if running in Service Mode). For more information, see “Starting 
and Exiting AutoReceive” on page 61.

Configure AutoReceive to Write to a Network Drive

1. From the Windows Start Menu, click Settings > Control Panel > Administrative Tools > 
Services.

2. From the Services dialog box, select AutoReceive.

3. Right-click on AutoReceive, and then click Properties.

● In the AutoReceive Properties dialog box, click the Log On tab.

● Select the This account radio button.

● Confirm the account name and type the password. At Confirm password, type the 
password again.

4. Click OK.

Note: Only accounts which have their "Logon as Service" permission set can be used 
to run a service. 
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5. Start AutoReceive. If AutoReceive is running in Classic Mode, set it to run as a 
Service. For information on setting AutoReceive to run as a Service, see See “About 
Running AutoReceive as a Windows Service” on page 4.

6. Right-click the AutoReceive Icon and choose Advanced Settings from the menu.

7. Choose the Service mode and click OK.

8. Right-click the AutoReceive Tray Icon and choose Configure Subscription from the 
menu.

9. Under Distribution, type the network path of the file in which you want to save your 
results.

Note: Uniform naming conventions should be used when selecting the network folder to 
save results to (for example, \\ComputerName\FolderName). The path should not contain 
a drive letter, and the folder should be accessible by the account configured above.
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Uninstalling AutoReceive 
If you need to uninstall AutoReceive, you can use the Add/Remove Programs option from the 
Windows Control Panel. You must exit the AutoReceive application before uninstalling. (For 
instructions on exiting, see “Starting and Exiting AutoReceive (Classic Mode)” on page 63.) 

Uninstall AutoReceive from Windows Vista, Windows 7, or Windows Server 2008

1. If AutoReceive is currently running, exit AutoReceive before you continue.

To do so, right-click the AutoReceive icon ( ) in the notification area, and then 
click Exit.

2. If AutoReceive is running as a service, stop the service by doing the following:

a. From the Start menu, navigate to Control Panel > Administrative Tools > Services.

b. Right-click AutoReceive.

c. Click Stop.

3. Access the Windows Control Panel (for example, click Start > Control Panel).

4. From the Control Panel, under Programs, click Uninstall a Program, or double-click 
Programs and Features in Windows Server 2008. 

Note: You must have administrator privileges on a computer to uninstall AutoReceive from that 
computer.
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5. At Uninstall or change a program, select AutoReceive from the list of programs. 

6. Click Uninstall/Change.

7. At User Account Control, click Continue to verify that you want to uninstall 
AutoReceive. 

8. At Uninstall AutoReceive, click Uninstall to confirm that you want to uninstall 
AutoReceive. 

Note: If an earlier version of AutoReceive is installed to more than one Windows Vista, 
Windows 7, or Windows Server 2008 user account (on the same computer), only the first 
user can uninstall from the Control Panel. If AutoReceive does not appear in the list of 
programs, it may have been uninstalled previously from another user account. In this case, 
do the following:

1. Access the user’s AutoReceive uninstall directory (for example, 
C:\Users\username\
AppData\Local\Program Files\AutoReceive\Uninstall_eMaxx_AutoRe
ceive).

2. Double-click Uninstall eMaxx AutoReceive.exe.
3. Continue with step 7.
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9. When the Uninstall Complete message appears, click OK to close the dialog box. 

10. Close the Control Panel.
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Uninstall AutoReceive from Windows XP, Windows 2000, or Windows Server 2003

1. If AutoReceive is currently running, exit AutoReceive before you continue. 

To do so, right-click the AutoReceive icon ( ) in the notification area, and then 
click Exit.

2. If AutoReceive is running as a service, stop the service by doing the following:

a. From the Start menu, navigate to Control Panel > Administrative Tools > Services.

b. Right-click AutoReceive.

c. Click Stop.

3. Access the Windows Control Panel.

For example, on Windows XP, click Start > Control Panel.

4. From the Control Panel, double-click Add or Remove Programs. 

5. At Add or Remove Programs, select AutoReceive from the list of Currently installed 
programs. 

6. Click Change/Remove.
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7. At Uninstall AutoReceive, click Uninstall to confirm that you want to uninstall 
AutoReceive. 

8. When the Uninstall Complete message appears, click OK to close the dialog box. 

9. Close Add or Remove Programs.

10. Close the Control Panel.
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About Using AutoReceive 
Once configured, AutoReceive runs automatically while your computer is on, requiring no 
further interaction. If you need to add, modify, or remove a subscription, or change your 
connection settings, you can access the AutoReceive menu options by right-clicking the 
AutoReceive icon ( ). The AutoReceive icon appears in the notification area, at the far right 
of the Windows taskbar. 

Note: If AutoReceive is running as a Windows service, the AutoReceive icon may not appear in the 
notification area. To access the AutoReceive user interface, click Start > All Programs > AutoReceive > 
AutoReceive. For more information, see “About Running AutoReceive as a Windows Service” on 
page 4. 
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Managing Subscriptions
Subscriptions are usually configured following installation and remain active until you 
remove or modify them. You can also add new subscriptions to the document types if new 
accounts become available.

Accessing Subscription Summary Information 
You can access and view subscriptions that are currently configured for your account in two 
locations:

● Account Summary. The Account Summary provides a brief summary of all subscriptions 
that are configured for each account. From the Account Summary, you can determine 
which type of subscription is configured for the account, for example, HL7 or PDF, as well 
as the subscription name as specified during configuration. You cannot edit the 
subscriptions from the Account Summary.

● Subscription Summary. The Subscription Summary provides a detailed view of the 
subscription’s parameters that you specified during configuration. You can edit the 
parameters by selecting the appropriate subscription and selecting Configure. See 
“Modifying a Subscription” on page 44 for more information.

Access the Account Summary 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click 
Configure Subscriptions.

2. At Manage Subscriptions, click the Account Summary link. 

3. Review the Account Summary.

Subscriptions are listed by account. The name listed in the HL7 or PDF column 
reflects the name of the subscription as specified during configuration. 

4. When you have finished reviewing the summary, click Close.
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Access the Subscription Summary 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click 
Configure Subscriptions.

2. At Manage Subscriptions, select Choose from the following available subscriptions.

3. From the list of available subscriptions, select the desired subscription.

4. To view and/or modify the configuration for the selected subscription, click 
Configure.

For additional information on modifying subscriptions, see “Modifying a 
Subscription” on page 44.
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Adding a Subscription 
You can add a new subscription any time there is an available provider account that is not yet 
associated to a subscription type (HL7 or PDF). Since HL7 and PDF subscriptions can each 
be associated with one or more provider accounts, you may need to configure only one HL7 
subscription and one PDF subscription, so that all your specified delivery options apply 
across the board to each associated account. If you need to, you can configure multiple 
subscriptions, one HL7 and one PDF, for each provider account, specifying unique 
parameters such as print locations and result types.

Add a Subscription 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click 
Configure Subscriptions.

2. At Manage Subscriptions, select Create new subscription.

3. Click either HL7 Test Results, Printable Test Results, or Clinical Document Upload. 

4. Click Continue.

See “Configuring HL7 Test Results” on page 16, “Configuring Printable Test 
Results” on page 21, or “Configuring Clinical Document Uploading” on page 27 
for more information on configuring document types and specifying subscription 
parameters.

Note: If you select a subscription type (HL7 or PDF) that is already assigned to the available 
account(s), you are notified that it is unavailable for configuration.
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Modifying a Subscription
If you need to make changes to a subscription (for example, routing your results to a 
different printer), you can access the subscription’s existing configuration and make the 
necessary changes. You can also adjust the interval at which you receive results, or change 
account associations.

Modify a Subscription 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click 
Configure Subscriptions.

2. At Manage Subscriptions, select Choose from the following available subscriptions.

3. From the list of available subscriptions, select the subscription that you want to 
modify.

4. Click Configure.

5. Make any necessary changes to the configuration, and then click Continue.
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6. At Associate Accounts, select or clear (as appropriate) the account(s) to which the 
modified subscription parameters should be applied. 

7. Do one of the following:

● To return to the previous configuration page to make changes prior to saving, 
click Back.

● To save your selections and return to the Manage Subscriptions page, click Save.

If you are finished configuring subscriptions, click Close.

● To exit the subscription configuration without saving your changes and return 
to the Manage Subscriptions page, click Cancel.
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Removing a Subscription
If you are no longer receiving results from a service provider, you can remove the associated 
subscription from AutoReceive. Also, if there are any connectivity problems with a particular 
service provider, you can remove the subscription to avoid gathering error messages in your 
Status Log, and then reconfigure the subscription again when the problem is resolved. See 
“Viewing the Status Log” on page 58 for more information.

Remove a Subscription 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click 
Configure Subscriptions.

2. At Manage Subscriptions, select Choose from the following available subscriptions. 

3. From the list of available subscriptions, select the subscription that you want to 
delete, and then click Delete.

4. When prompted, click Yes to confirm the deletion. 
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Changing Configuration Settings 
Your login information and modem connection settings that you configured during 
installation and setup remain active until you change them. To change these settings 
manually, access the right-click menu from the AutoReceive icon ( ) in the notification area.

Changing Login Information 
If you need to change your login information, call your System Administrator to get the 
appropriate Username and/or Password before accessing the menu options to make changes.

If you receive an authentication error (your login information is not accepted), contact your 
System Administrator to determine if changes have been made to your login credentials.

Change Login Information 

1. Obtain the new login Username and/or Password from your System Administrator.

2. Right-click the AutoReceive icon ( ) in the notification area, and then click Change 
Login Information.

3. Type the new account Username or Password, and then click OK. 

A message box appears, indicating that the Username has been changed, and that 
all existing subscriptions will be deleted. 

4. Click OK to close the message box.

5. Restart AutoReceive, and create one or more new subscriptions.

For information on starting AutoReceive, see “Starting and Exiting AutoReceive” 
on page 61.

Note: If you receive an authentication error (your login information is not accepted), contact your 
System Administrator to determine if changes have been made to your login credentials.

Notes:
● If you change only your Password, your subscriptions are saved. If you change both your Username 

and Password, the subscriptions for the previous Username are deleted and you must reconfigure 
them.

● Your System Administrator can provide you with valid login information and make sure your new 
information is successfully accepted.
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For information on configuring subscriptions, see “Configuring HL7 Test Results” 
on page 16 and “Configuring Printable Test Results” on page 21.

Changing Connection Settings
When you start AutoReceive for the first time, you specify whether your computer connects 
to the Internet using a dial-up modem or a LAN connection. See “Logging In to 
AutoReceive” on page 11 for more information on specifying connection settings. You can 
change the settings if your method for connecting to the Internet changes.

Change Connection Settings 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click 
Network Configuration.

2. At Network Configuration, specify your connection type by selecting one of the 
following:

● Select LAN if your computer accesses the Internet using a LAN.

Some LAN connections use a proxy server for HTTP and HTTPS connectivity. 
If your computer uses a proxy server, select the Use proxy server check box, and 
then type the Proxy host and Port information. If your proxy server requires you 
to log in, also type your Username and Password (provided by your System 
Administrator; this is not your AutoReceive Username and Password).

To determine if your LAN connection uses a proxy server, check your browser’s 
settings by selecting Tools > Internet Options on the browser menu bar. Click the 
Connections tab. Click LAN Settings. See if the Use a proxy server for your LAN check 
box is selected.

● Select Modem if your computer accesses the Internet using a modem. Select 
Disconnect after finished download to automatically disconnect your modem after 
each transmission of results.

3. To save your changes, click OK.
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Changing Notification Options 
After you have logged into AutoReceive, it remains active, running in the background until 
you log off or close the application. The program icon ( ) in the notification area indicates 
that AutoReceive is running. When an AutoReceive communication session is in progress, 
that is, when results are being downloaded or when the application is being automatically 
updated, the system icon changes to a communication icon ( ) until the session ends, at 
which time it reverts to the normal icon.

In addition to the communication icon, you can monitor the status of communication 
sessions by choosing to display a small status window on your screen that provides 
information about the success or failure of communications activity such as connections, 
downloads, saves to disk, printing and system updates. 

● The upper text line of AutoReceive Status displays the state of AutoReceive, or what action 
is occurring. Idle indicates that AutoReceive is connected, but no data is being received at 
this time.

● The lower text line displays the time and completion status of the last communication 
session. If a communication session is unsuccessful, an alert message displays in this 
location.

● You can drag the AutoReceive Status window from its default location above the notification 
area to any place on the screen. It remains in your preferred position until you change it. 

You must have at least one subscription configured before you can set Notification Options. 
The option you set applies to all subscriptions; options for different subscription types 
cannot be separately configured.

Change Notification Options 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click 
Notification Options.

2. Select one of the following options: 

● Always. The status window appears after the startup process has completed, and 
remains visible until you exit AutoReceive.
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● During AutoReceive activity. The status window appears when a communication 
session begins (for example, retrieval of HL7 or Printable results), and remains 
visible until two minutes after the session has completed. 

● During User-Initiated activity. The status window appears only when you initiate a 
communication session (for example, Download Now, Redownload Now, Send 
Status/Errors, or Check for Update Now), and remains visible until two minutes after 
the session has completed.

● Never. The status window does not appear on your screen at any time.

● Always on Top. The status dialog stays on top of all other windows.

3. To save your selection, click Save.

Note: During AutoReceive activity is the default option. 

Notes:
● Regardless of which display option you select, you can close the AutoReceive Status 

window at any time by clicking Close in the upper-right corner of the screen.
● If you close the window manually, the window reappears at the start of the next 

communication session (unless you have chosen to never display it).
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Responding to AutoReceive Connection Failures 
AutoReceive opens and connects to the server each time you start your computer. If 
AutoReceive cannot connect to the server when it starts, either after a restart or when you 
initially turn on your computer, you are prompted to exit AutoReceive or let the system try 
to connect to the server. The system will make connection attempts every 10 minutes for a 
maximum of one hour, after which it will try to connect every 90 minutes for an indefinite 
period of time or until you close AutoReceive.

After 48 hours, if a connection has not been established, a dialog box appears from which 
you can either close AutoReceive or let the system continue trying to connect at 90-minute 
intervals. If you choose to let the system continue trying to connect, the dialog box reappears 
after another 48-hour interval of unsuccessful connection. Once AutoReceive begins 
retrying connection at 90-minute intervals, it continues to do so until connection is 
established—even if you have not responded to the dialog box prompts—or until you close 
it, which you can do at any time (see “Starting and Exiting AutoReceive” on page 61).

Respond to AutoReceive Connection Failures 

1. At Unable to Connect, do one of the following: 

● To close the program and discontinue connection attempts, click 
Terminate AutoReceive.

● To close the dialog box and allow AutoReceive to continue trying to connect 
with the server, click Continue Retry Attempts.

● To update the network configuration settings, click Network Configuration. (For 
more information, see “Changing Connection Settings” on page 48.)

● To reset your password to match a new password that has been established for 
you by MedPlus Customer Support, click Change Password. 

2. Do one of the following, based on the selection you made in the previous step:

a. If you clicked Terminate AutoReceive, do one of the following to respond to the 
confirmation prompt: 

❍ To exit AutoReceive and terminate connection retry attempts, click Yes.

Note: The Change Password button appears only if the connection failure is due to a 
change in your password (for example, Customer Support may need to reset your 
password to resolve a connection issue). When your password changes, you are 
prompted to enter the new password the first time you attempt to log in after the 
change has been made. 
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❍ To keep AutoReceive running, click No.

Connection attempts will be made every 10 minutes for the first hour, and 
then every 90 minutes thereafter, until you exit AutoReceive.

b. If you clicked Continue Retry Attempts, but reconnection has been unsuccessful 
for approximately 48 hours, do one of the following when the message prompt 
appears:
❍ To close AutoReceive, click Terminate AutoReceive.

❍ To allow AutoReceive to continue attempting to connect, click Continue Retry 
Attempts.

c. If you clicked Change Password, do the following:
❍ At AutoReceive Setup, type (and then re-type) the new password, and then click 

Change Password. 

❍ At Change Password, click OK to acknowledge the change. 

❍ At Unable to Connect, click Terminate AutoReceive, and then restart AutoReceive 
using the new password.
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Downloading Results Manually 
Although AutoReceive is configured to receive results at the specific times or intervals you 
specify, you can request an immediate download or redownload of information.

Downloading Current Results 
Instead of waiting for the automatic or timed download of results, you can manually request 
an immediate download of results at any time. This may be useful when you are seeing a 
patient whose lab results are ready but not yet received. A manual download retrieves only 
completed results that have not yet printed or saved. This ensures that you do not receive 
duplicate results.

After a manual download, the next scheduled download excludes the results you already 
requested (this also applies for scheduled downloads). For example, if AutoReceive is 
configured to download results every two hours, but you request a manual download after 
one hour, the next download will include only those results received during the 60 minutes 
after the manual download.

Download Current Results 

Right-click the AutoReceive icon ( ) in the notification area, and then click 
Download Now.

The results, if available, are retrieved and saved or printed according to your 
subscription configuration.

Redownloading Results 
If you need to redownload results that have already been received, you can access the 
AutoReceive Redownload feature, enter the date parameters for the appropriate days, and 
download the results. 

Note: You cannot manually download results during the subscription configuration process. You 
must either complete the subscription configuration or cancel out of the configuration screens prior 
to manually downloading results.

Note: If you are using the Enhanced file naming mode and need to redownload results, the 
redownloaded file names are generated using the current time. As a result, it is possible that there 
will be two identical files with different timestamps. You can determine which file to use by comparing 
the file names, and using the one with the latest timestamp. (For more information on the Enhanced 
naming mode, see “File Naming Mode” under “Step 2: Configure Subscription” on page 14.)
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Redownload Results 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click 
Redownload Now.

2. At From and To, type a date range for the redownloaded documents using the 
format mm/dd/yyyy. 

3. Click Download.

Reprint Last Reports
AutoReceive allows the most recent set (batch) of downloaded results to be reprinted. After 
a successful printable result download, the results are stored in a temporary directory within 
the AutoReceive install directory to allow reprinting if requested. The client can request a 
reprint of the last batch by right-clicking the AutoReceive icon and choosing Reprint Last 
Reports from the pop-up menu.

Reprint Last Reports

1. Right-click the AutoReceive icon ( ) in the notification area, and then click 
Reprint Last Reports.

2. If reprinting is successful, a dialog appears informing you what was reprinted. 

If no results are available for reprinting, a dialog appears informing you that no 
reports are available for reprinting.

Note: You cannot download results that are more than 90 days old.
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Sending Status and Error Logs Manually 
AutoReceive improves the process of resolving system problems and diagnosing critical 
errors that may occur by automatically collecting information about your configuration and 
use of AutoReceive. The collected information is stored in log files that are saved on your 
computer, and the information is periodically forwarded (automatically) to MedPlus 
Customer Support personnel. By default, AutoReceive sends status information every three 
days, and error information once a day, as needed. (If no errors occur on a particular day, 
then no error log is sent that day.)

Though AutoReceive is configured to send the status and error data automatically, you can 
also request that the status and error information be sent immediately; for example, if you 
are working with Customer Support on a particular issue or error.

Send Status and Error Logs 

Right-click the AutoReceive icon ( ) in the notification area, and then click 
Send Status/Errors.

The latest status and error log files that are stored on your computer are sent 
immediately to MedPlus Customer Support. (To verify that the status and/or error logs 
were sent successfully, you can view the status log. For details, see “Viewing the Status 
Log” on page 58.)

If an error occurs when attempting to send status and error logs, a message appears, 
indicating the error condition. 
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Downloading Product Updates 
AutoReceive updates are typically downloaded to your computer automatically as they 
become available. AutoReceive checks for these updates approximately every two days. 
Although you do not have to manually install the updates, you can check for product updates 
at any time and install them if they are available. Additionally, automatic updating may not 
be available for some installations. In these cases, you will be notified that an update is 
available via a dialog box, as well as a flashing AutoReceive icon in the notification area. 
Manual updates are performed using the Check For Update Now menu option. 

The Status Log tracks all product updates that have been completed. You can check the Status 
Log to see when AutoReceive was updated and if the update was successful. See “Viewing the 
Status Log” on page 58 for more information on reading log file messages.

Download Product Updates 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click 
Check for Update.

AutoReceive checks to see if an update is available.

2. If an update is available you will be prompted to install it. Click Yes to begin 
installation. 

3. When you are notified that the uninstall is complete, click OK.

The new version of AutoReceive is installed.

4. To confirm whether or not the update was successful, right-click the AutoReceive 
icon ( ) in the notification area, and then click Check For Update.

If the update was successful, the AutoReceive is up to date message appears.
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Viewing the Print Log 
Any print jobs that are sent to the configured printer while AutoReceive is running are saved 
to a print log. You can periodically check the print log to determine whether or not the print 
jobs have been completed properly. If needed, you can redownload files using the date and 
time values from the Status Log to retrieve files that did not print or save. See 
“Redownloading Results” on page 53 for more information on re-downloading files.

View the Print Log 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click View 
Print Log.

2. Review the print messages. 

3. To refresh the print messages to ensure that you are viewing the latest information, 
click Refresh.

4. To clear all the messages, click Clear. 

5. When prompted, click Yes to confirm clearing the messages. 

Note: For instructions on configuring the printer that is used for automatic printing (for a Printable 
results subscription), see “Configuring Printable Test Results” on page 21.

Note: You cannot clear print messages individually. If you click Clear, all messages are 
deleted from the Print Log.
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Viewing the Status Log 
Any errors that occur while AutoReceive is running are saved to a status log. You can 
periodically check the status log to determine if any results retrievals have failed. If needed, 
you can redownload files using the date and time values from the Status Log to retrieve files 
that did not print or save. For more information, see “Redownloading Results” on page 53.

Additionally, the status log tracks when automatic and manual product updates are installed 
to your computer. Check the status log to see the product version that was installed and if 
there were any errors while attempting to update AutoReceive.

About the Error Messages
The following table includes some common error messages and their meanings. 

Error Description

Error while executing:<subscription 
name><message>

Problem with the subscription, service may be 
down.

A Remote error occurred while trying 
to contact the web service. Please try 
again later.

Service is down.

No Service Providers were found for 
this account.

Possible misconfiguration.

Authentication failure. Bad credentials (for example, username or 
password).

Cannot retrieve document types, 
authentication failure.

Bad credentials.

Error printing PDF file: <message> A corrupt PDF file or printer error. If corrupt 
file, contact your System Administrator.

An error occurred while retrieving 
document types.

Service could be down.

An error occurred while trying to 
contact the web service.

Service could be down.

Execution Exception: a SOAP Fault 
occurred while trying to contact the 
web service. Please try again later.

AutoReceive is having trouble connecting to 
the server either during startup or while trying 
to receive results.

Error while executing: HL7 Test 
Results A SOAP Fault occurred while 
trying to contact the web service.

The retrieval of results for an HL7 subscription 
that is scheduled at a particular time fails 
because of the SOAP fault.

Error while executing: Printable Test 
Results A SOAP Fault occurred while 
trying to contact the web service.

The retrieval of the results for a PDF 
subscription that is scheduled at a particular 
time fails because of the SOAP fault.

Note: For assistance understanding or resolving error messages, see your System Administrator.
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View the Status Log 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click View 
Status Log.

2. Review the error and/or system update messages. 

3. To refresh the status messages to ensure that you are viewing the latest information, 
click Refresh.

4. To clear all the messages in the status log, click Clear. 

When prompted, click Yes to confirm clearing the messages. 

5. To close the AutoReceive Status Log window, click Close.

Note: You cannot clear error messages individually. If you click Clear, all messages are 
deleted from the AutoReceive Status Log window.
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Viewing the Configuration Settings 
The AutoReceive Configuration dialog box, accessed from the AutoReceive Status Log, allows you 
to view the current AutoReceive configuration settings. The configuration settings are read-
only, and are to be used primarily when working with Customer Support for troubleshooting 
purposes.

View the Configuration Settings 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click View 
Status Log.

2. From the AutoReceive Status Log, click View Configuration. 

3. View the AutoReceive Configuration settings. 

4. To close the AutoReceive Configuration window, click OK.

5. To close the AutoReceive Status Log window, click Close.
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Starting and Exiting AutoReceive 
AutoReceive can run in one of the two following modes:

● As a Windows service (referred to as “Service Mode”)

● As a standard Windows application (referred to as “Classic Mode”)

The mode in which AutoReceive runs determines how the application can be started and/or 
exited, as explained in this section. For instructions on starting and exiting AutoReceive in 
each mode, refer to the appropriate section below:

● If AutoReceive is running as a Windows service, see “Starting and Exiting AutoReceive 
(Service Mode)” on page 61.

● If AutoReceive is running as a standard Windows application, see “Starting and Exiting 
AutoReceive (Classic Mode)” on page 63. 

Starting and Exiting AutoReceive (Service Mode) 
If AutoReceive is running as a Windows service, there are two separate components of 
AutoReceive, each of which is started and/or exited independently: 

● Application (Service). The first component, the AutoReceive application (service), starts 
automatically each time the computer is restarted. The AutoReceive service operates in 
the background, and does not provide a method for stopping or exiting the service. 
However, if the service should unexpectedly stop running for any reason, it can be 
manually restarted.

You will be notified in two ways if the service is stopped:

❍ The following dialog box appears, informing you that the service has stopped: 

❍ The AutoReceive icon in the notification area displays a red X ( ).

Notes:
● To determine whether or not AutoReceive is running in Service Mode on your computer, you 

can view your current configuration settings. For instructions, see “Viewing the Configuration 
Settings” on page 60.

● You must run AutoReceive as an administrator under Windows Vista, Windows 7, and Windows 
Server 2008 (if you do not, service mode will not work correctly).

Note: For more information about the two possible installation modes, see “About Running 
AutoReceive as a Windows Service” on page 4.
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Chapter 2: Using AutoReceive 

● User Interface. The second component, the AutoReceive user interface, is started via the 
AutoReceive option in your Windows Startup folder. The AutoReceive user interface starts 
automatically each time the computer is restarted. The AutoReceive user interface 
continues to run until you either exit it manually, or until you turn off your computer. 
Starting or exiting the AutoReceive user interface has no impact on the AutoReceive 
service, which continues to run regardless.

It is possible that the AutoReceive user interface may be running even if the service has 
been stopped. If you attempt to exit the AutoReceive user interface while the service is 
stopped (as described above), the following dialog box appears, informing you that you 
will not continue to receive subscription results until the service is restarted: 

Start the AutoReceive User Interface (Service Mode) 

Do one of the following:

● To restart the AutoReceive user interface manually, click Start > All Programs > 
AutoReceive > AutoReceive.

● To restart the AutoReceive user interface automatically (by restarting 
Windows), click Start > Shut Down, select Restart, and then click OK. 

Restart the AutoReceive Service (Service Mode) 

1. If the AutoReceive user interface is not currently running, start it by following the 
instructions in “Start the AutoReceive User Interface (Service Mode)” on page 62. 
Otherwise, proceed to step 2.

2. Right-click the AutoReceive icon ( ) in the notification area, and then click 
Restart Service.

Exit the AutoReceive User Interface (Service Mode) 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click Exit.

2. When prompted, click Yes to confirm that you want to exit the user interface. 

Note: Procedures may vary slightly based on your Windows operating system.



63 Starting and Exiting AutoReceive
• 
• 
• 
•
•
•

The AutoReceive user interface closes, but the AutoReceive service continues to 
run in the background. Results will continue to be received and/or printed as 
normal. 

Starting and Exiting AutoReceive (Classic Mode) 
If AutoReceive is running as a standard Windows application on your computer, the 
application opens each time the computer is restarted. AutoReceive continues to run until 
you either exit the application manually, or until you turn off your computer.

If you need to manually exit AutoReceive due to printer, connectivity, or network issues, you 
must manually restart AutoReceive in order to resume receiving results. To discontinue 
receiving results without turning off your computer, you can exit AutoReceive manually.

Start AutoReceive (Classic Mode) 

Do one of the following:

● To restart AutoReceive manually, click Start > All Programs > AutoReceive > 
AutoReceive.

● To restart AutoReceive automatically (by restarting Windows), click Start > Shut 
Down, select Restart, and then click OK. 

Exit AutoReceive (Classic Mode) 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click Exit.

2. When prompted, click Yes to confirm that you want to exit the application. 

AutoReceive closes, and the receipt of results is discontinued. 

Note: If the AutoReceive icon in the notification area displays a red X ( ) (meaning the 
service has been stopped) when you exit the user interface, you will not continue to receive 
subscription results until the service is restarted. 

Note: Procedures may vary slightly based on your Windows operating system.

Note: To restart AutoReceive manually, see Start AutoReceive (Classic Mode)above.
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Switching Between Service Mode and Classic Mode 
When you initially install AutoReceive, it is configured to run either as a Windows service or 
as a standard Windows application, depending on whether it is a new install, or is obtaining 
settings from a previous install of AutoReceive (for more information, see “About Running 
AutoReceive as a Windows Service” on page 4). Normally, once AutoReceive is successfully 
installed, it continues to run in its selected mode without interruption.

There are several environmental factors, however, that may impede AutoReceive’s ability to 
run successfully in Service Mode; for example, if you have configured a subscription to save 
results to a network drive, or if you are using a Windows firewall or anti-virus application that 
impedes AutoReceive’s communications. In these situations, it is possible to change 
AutoReceive’s operating mode from a Windows service to a standard Windows application 
to work around the issue. (It is also possible to change back to Service Mode, as needed; for 
example, if the impeding issue is corrected.) 

Switch Between Service Mode and Classic Mode 

1. Right-click the AutoReceive icon ( ) in the notification area, and then click 
Advanced Settings.

2. At Mode, click either Service or Classic to indicate the mode in which you want 
AutoReceive to operate. 

3. When prompted, click Yes to confirm that you want to change AutoReceive’s 
operating mode. (Note that the message varies, depending on whether your are 
switching from Classic Mode to Service Mode, or vice versa). 

Note: Refer to the AutoReceive Readme file for more information on the environmental issues that 
can impede AutoReceive’s Service Mode operation.

Tip: The current operating mode is selected by default. To close the dialog box without 
making any changes, click Cancel.
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4. When prompted, click OK to exit AutoReceive. 

AutoReceive must be closed and restarted in order to run in the new mode.

5. To restart AutoReceive, click Start > All Programs > AutoReceive > AutoReceive.

For more information about starting AutoReceive in either mode, see “Starting and 
Exiting AutoReceive” on page 61.
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We’d Like to Hear From You 

After you have had a chance to use the Manual and/or Help for this product, please take a 
moment to give us your comments. Respond to the questions below, and return this form (or 
send comments via e-mail) to MedPlus at your convenience. Thank you!

✔ What MedPlus product are you using? (Please provide version number)

_____________________________________________________________________

✔ What documentation do you refer to most often?

____ Manual ____ Help

✔ What chapters or topics do you refer to most often?

_____________________________________________________________________
_____________________________________________________________________

✔ How often do you expect to refer to the Manual?

____ Often ____ Occasionally ____ Never

The Help?

____ Often ____ Occasionally ____ Never

✔ How is the level of detail in the Manual?

____ Too little ____ Just right ____ Too much

In the Help?

____ Too little ____ Just right ____ Too much

✔ Does the documentation adequately explain how to get started using the product?

____ Yes ____ No

If not, what information is missing?
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________

✔ How do you normally search for information in the Manual and/or Help?

____ Scan ____ Table of Contents ____ Index
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✔ Was there an index entry you looked for in the Manual or Help but couldn’t find?

____ Yes ____ No

If so, what was it? _______________________________________________________

✔ Did you find any errors in the Manual or Help?

____ Yes ____ No

If so, please list the page number or topic, and describe the error:

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

✔ Any other comments about the documentation?

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

Please tell us about yourself (optional)

Name: ________________________________________________________________

Title/position: _________________________________________________________

Company name: ________________________________________________________

Address: _______________________________________________________________

Country: ______________________________________________________________

Phone: ________________________________________________________________

E-mail: ________________________________________________________________

May we contact you for additional feedback?

____ Yes ____ No

Send your comments to MedPlus

Please send your comments in any of the following ways: 

By Mail:

MedPlus, Inc.
Attn: Technical Communications Manager
4690 Parkway Drive
Mason, OH 45040 USA

By Fax:

(800) 381-4048

By E-mail:

doc@medplus.com

mailto:doc@medplus.com
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